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Warranty and Liability 
 

Note The Application Examples are not binding and do not claim to be complete 
regarding the circuits shown, equipping and any eventuality. The Application 
Examples do not represent customer-specific solutions. They are only intended 
to provide support for typical applications. You are responsible for ensuring that 
the described products are used correctly. These Application Examples do not 
relieve you of the responsibility to use safe practices in application, installation, 
operation and maintenance. When using these Application Examples, you 
recognize that we cannot be made liable for any damage/claims beyond the 
liability clause described. We reserve the right to make changes to these 
Application Examples at any time without prior notice.  
If there are any deviations between the recommendations provided in these 
Application Examples and other Siemens publications – e.g. Catalogs – the 
contents of the other documents have priority. 

We do not accept any liability for the information contained in this document. 
Any claims against us – based on whatever legal reason – resulting from the use 
of the examples, information, programs, engineering and performance data etc., 
described in this Application Example shall be excluded. Such an exclusion shall 
not apply in the case of mandatory liability, e.g. under the German Product Liability 
Act ("Produkthaftungsgesetz"), in case of intent, gross negligence, or injury of life, 
body or health, guarantee for the quality of a product, fraudulent concealment of 
a deficiency or breach of a condition which goes to the root of the contract 
("wesentliche Vertragspflichten"). The damages for a breach of a substantial 
contractual obligation are, however, limited to the foreseeable damage, typical for 
the type of contract, except in the event of intent or gross negligence or injury to 
life, body or health. The above provisions do not imply a change of the burden 
of proof to your detriment. 
Any form of duplication or distribution of these Application Examples or excerpts 
hereof is prohibited without the expressed consent of the Siemens AG. 

 

Security 
infor-
mation 

Siemens provides products and solutions with industrial security functions that 
support the secure operation of plants, systems, machines, and networks. 
In order to protect plants, systems, machines and networks against cyber 
threats, it is necessary to implement – and continuously maintain – a holistic, 
state-of-the-art industrial security concept. Siemens’ products and solutions 
only form one element of such a concept. 
Customer is responsible for preventing unauthorized access to their plants, 
systems, machines, and networks. Systems, machines, and components should 
only be connected to the enterprise network or the Internet if and to the extent 
necessary and with appropriate security measures in place (e.g. use of firewalls 
and network segmentation).  
Additionally, Siemens’ guidance on appropriate security measures should be 
taken into account. For more information about industrial security, please visit 
http://www.siemens.com/industrialsecurity. 

Siemens’ products and solutions undergo continuous development to make 
them more secure. Siemens strongly recommends applying product updates 
as soon as they are available and to always use the latest product versions. 
Use of product versions that are no longer supported and failure to apply the 
latest updates may increase customer’s exposure to cyber threats. 
To stay informed about product updates, subscribe to the Siemens Industrial 
Security RSS Feed under http://www.siemens.com/industrialsecurity. 

http://www.siemens.com/industrialsecurity
http://www.siemens.com/industrialsecurity
http://www.siemens.com/industrialsecurity
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1 SIMIT at a glance 

1.1 What is SIMIT Simulation? 

Description 

At the engineering stage in particular, the three factors below come to the fore: 

 Quality 

 Costs 

 Time 

 

System individuality and high availability play an ever more important role. 
The engineering stage extends far into the operating stage of the system. 
This results in projects that are much more complex, a reduction in the time frame 
for engineering, and increased pressure on each person involved in the project. 

SIMIT Simulation (which will be referred to from now on as SIMIT) can contribute 
to increased cost efficiency. SIMIT is a simulation platform for virtual 
commissioning of the user software in automation systems. In doing so, 
SIMIT places a wide spectrum of the plant simulation at your disposal. Starting 
with simulation of input and output signals, through simulation of field equipment, 
to modeling of the overall process. 
 

Figure 1-1: Comparison of a real plant and a simulated one 

PLCSIM Virtual Controller

Real Plant Simulated Plant

SIMIT Simulation

Automation Systems

IO Devices

Actuators / Sensors

Plant / Machines

Simulation

of Signals

Simulation

of Devices

Simulation of

technological

behavior

SimulationUNIT

PLC

Software in the Loop Hardware in the Loop

100.0

65.7

 

Simulation using SIMIT allows you to test the automation software using real 
hardware (Hardware in the Loop, or "HiL") or using emulated hardware (Software 
in the Loop, or "SiL"). The system simulation is created in SIMIT. This simulation 
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mirrors the behavior of the system and is connected to a real controller via an 
interface module for PROFIBUS, PROFINET, or an emulator. 

This means that simulation using SIMIT can bring cost savings and increase the 
quality of automation projects. Due to its wide spectrum, SIMIT supports you at 
every stage of your project. It is possible to detect possible sources of error at an 
early stage and to eliminate them economically during this period of the planning 
phase. In the same way, faults can be simulated without any risk to staff, 
the environment, and the plant. 

Simulation in SIMIT is subdivided into three levels: 

 Signal level 

 Device level 

 Process level 

 

Signal level 

Plant signals are simulated on the signal level. SIMIT offers supporting tools for 
defining and scaling signals. 

You can carry out a functional test in SIMIT as soon as you have created the 
signals. PLCSIM makes available dialogs for this that you can use to monitor or 
change signals on the basis of the I/O address. The Virtual Controller does not 
offer this function; however, using the Virtual Controller, you can also carry out 
a signal test at an early stage using variable tables in the SIMATIC Manager, 
for example. 

 

Device level 

On the device level, the system maps the actuators and sensors in the system 
like valves or motors, for example. To do this, SIMIT comes with ready-made 
components to simulate the behavior of the devices. You can connect them to 
the signals from the signal level. 

Apart from this, SIMIT offers templates and tools that you can use to create 
actuators and sensors by importing PCS 7 configuration data. 

This makes it possible to test run-time behavior (e.g. opening a valve) and 
feedback (e.g. reaching limit switches). This increases the quality of the simulation 
and has the advantage that you can implement the automation software in the 
real plant with a high level of quality assurance. 

 

Process level 

The physical model of the plant is represented on the process level. With 
a variety of library components from the base library as well as the CHEM-BASIC, 
FLOWNET, and CONTEC libraries that can be purchased in addition to the base 
library, SIMIT provides you with a platform that allows you to create physical 
models. 

The Component Type Editor (CTE) is an additional tool that gives you a high 
degree of flexibility. You can develop your own components or adapt existing 
ones to your own applications. 
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1.2 Aim of SIMIT Simulation Getting Started 

In the course of this Getting Started document, you will get to know the following 
procedures: 

 Using SIMIT to create simulation models 
You will learn how to configure and use existing components for your 
simulation using the SIMIT library. You will also learn how to use SIMIT 
to visualize your process. For this, SIMIT provides you with an editor that you 
can use to create the user interface. This means that you can monitor the 
simulation process and, if necessary, intervene and control it if the situation 
demands it. 

 Emulating automation systems using the Virtual Controller 
The virtual controller simulates the behavior of a SIMATIC controller of type 
S7-300 or S7-400. The virtual controller is loaded with the original PLC user 
program. 

 Emulating automation systems using PCSIM 
You will learn how to configure PLCSIM and how to establish communication 
between PLCSIM and SIMIT. 

 

1.3 Structure of SIMIT Simulation 

The SIMIT user interface is divided into the following areas: 

(1) Project navigation 

(2) Work area 

(3) Tools 

(4) Properties 

 

Figure 1-2 The user interface 

1 2 3

4
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1.3.1 Menu and toolbar 

Figure 1-3 

 

 

In the menu and on the toolbar, you can carry out standard functions like saving 
and opening projects, for example. Apart from this, you can start simulation 
runtime. 

 

Figure 1-4 

 

 

In the Automatic modelling menu item, you can find functions for carrying out 
efficient configuration of the simulation model. 

 

1.3.2 Project navigation 

The Project window displays the currently open 
project in the Windows Explorer structure that you 
are familiar with. At the top the system shows the 
name of the open SIMIT project. 

The individual folders always contain a function, 
e.g. "New chart", and the objects that are created 
using this function. 

When you double-click on an object in the project 
window, the system either runs the function or 
displays it in the work area. 
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In project navigation, you can carry out the following functions: 

 

Table 1-1 

Symbol Name Description 

 
Project manager Opens project view in the work area. The view is the 

same as the one in project navigation. 

 

    

Couplings/  
New coupling 

In this folder, the system displays the functions for 
creating couplings as well as all the couplings that 
have already been created. 
The following couplings are available: 

 PROFIBUS DP 

 PROFINET IO 

 OPC SERVER 

 OPC CLIENT 

 SHM 

 PLCSIM 

 PRODAVE 

 VIRTUAL CONTROLLER 

 

    

Charts/ 
New chart 

In this folder, all the charts are stored that contain your 
plant's simulation models or visualization. You create 
a new chart by double-clicking on the "New chart" icon. 

 

    

    

    

Monitoring/ 
New trend 
Messages 
Archive 

In this folder, you can find different analysis tools: 

 Trend 
Visualization of signal paths 

 Messages 
(Displaying and exporting messages) 

 Archive 
(Archiving of signals via the simulation duration) 

 

    

Scripting/ 
New script 

In this folder, you create scripts. This tool makes it 
possible for you to access process signals at 
deterministically set times during runtime. This allows 
you to intervene in the process on an automated basis 
and to output information during simulation. You can find 
additional information on this topic in the "SIMATIC 
SIMIT (V9 SP1) manual 
https://support.industry.siemens.com/cs/ww/en/view/109
744640  

 
Snapshots Using this function, you can take snapshots and save 

them in the folder of the same name. The saved state 
of the process can be then loaded at any time using the 
shortcut menu of the saved snapshot. The simulation is 
continued from this state afterward. 

 
Find and replace Using this function, you can find and replace elements 

in the project. 

Note 

Before carrying out searching, save the project; 
otherwise, the result can be incomplete. 

 
Consistency check using this function, you test your project for errors 

 
Start You use this function to start the simulation. 

 

https://support.industry.siemens.com/cs/ww/en/view/109744640
https://support.industry.siemens.com/cs/ww/en/view/109744640
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1.3.3 Tools 

Depending on the object that is open in the working window, different tools are 
available: They are assigned to the following categories: 

 Components 

 Controls 

 Macros 

 Graphic 

 Templates 

 Projects 

 Signals 

 

Components 

On the "Components" task card, SIMIT provides 
a set of libraries to design simulations. The display 
area is divided up as follows: 

 Basic components 

 User components 

 Project components 

 Preview 

 

The basic component is similar to the PCS 7 block 
library and includes all the libraries provided by 
SIMIT. This Getting Started document focuses 
on the libraries: Communication, Connectors and 
Standard. 

On the "User Components" pane, you can store 
copies of components from the base library. In the 
library, you can edit the copied component that is 
available for configuration of your simulation. 
If you have created your own components, they 
can also be found in the "User Components" 
pane. 

In order for the created component to be assigned 
to the project, you must save them on the "Project 
Components" tab. 

Once you have archived the project and then 
dearchived it, the component is available to 
you again. 

In the last "Preview" pane, the system displays 
detailed information about the selected 
components. 
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Controls 

This tab contains all the components you need 
for input and output of process variables. Using 
the components from the "Inputs" pane, you can 
specify process variables at runtime. On the 
"Display" pane, you can find all the components 
that you need to display process values. 

With SIMIT version 7.1 and above, you can also 
use 3D objects for visualization on the "Others" 
tab. To integrate a 3D object, you need an object 
in ".wrl" format. 

The signal isolator is another element on the 
"Others" tab. You can use it to disengage signals 
from processes during runtime. After this, the 
disengaged signal can be manipulated by means 
of an input component like the slide, for example. 

 

Macros 

Using the macro function, you can combine several sub-components into one 
entire component. The generated component can be then inserted into a chart. 
As the figure below shows, a second order differential equation: 

 

Figure 1-5: Macro as a chart (on the left) and as a symbol in the character (on the right) 
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This makes it possible to group frequently used circuits. You generate inputs and 
outputs by dragging a line, e.g. from the Y output of the integrator to any cell on 
the sidebar. 

For more information about the functions of the Macro Component Editor, 
refer to chapter 3.4 of the SIMATIC SIMIT (V9.0 SP1) manual. 

https://support.industry.siemens.com/cs/ww/en/view/109744640/87976571659 

Graphic 

On the "Graphic" task card, you can find graphics 
tools that you can use to create graphics in charts. 

Using existing graphic elements, you can visualize 
your simulation in a chart according to your 
requirements. 

In addition to creating static graphic elements, 
SIMIT also allows you to create dynamic ones. 
Apart from process simulation, visualization of 
processes plays an important role in SIMIT. 

 

Templates 

The "Templates" task card consists of the 
following areas: 

 Basic Templates 
Here, you can find the templates that SIMIT 
provides. For example: components that 
simulate the behavior of the PCS 7 APL 
(Advanced Process Library). 

 User Templates 
Here, you can create your own components in 
global libraries. You can use these templates 
for any projects you like. These templates 
are not integrated in the project archive. 

 Project Templates 
Here, you store your own project-specific 
templates. They are archived with the project. 

 

 

 

https://support.industry.siemens.com/cs/ww/en/view/109744640/87976571659
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Projects 

On the "Projects" task card, you can access the 
objects and simulation models of existing projects. 
This allows you to reuse existing tested 
submodels. 

To do this, open the existing project and drag and 
drop the individual charts into your current project. 

After this, you can edit the chart in any way you 
like or copy it. 

 

 

Signals 

On the "Signals" task card, you can search for all 
of the signals in the project. A comprehensive filter 
function is available to make it easier to find 
signals. 

To connect object links to a signal, for example, 
you can simply drag and drop the object to the link 
in the properties window. 

Apart from this, you can have the system display 
the values of signals in the chart. To do this, drag 
and drop a signal onto a free surface in the chart. 
This creates the objects below and connects them 
to the signal: 

 Text field to the signal name 

 Signal isolator to force values at inputs and 
outputs 

 Digital input to display and input a value 
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1.3.4 Work area 

The system displays all of the SIMIT editors in the work area, e.g. the ones for 
charts, scripts, or curve displays. You open the appropriate editor by double-
clicking on an object in project navigation. 

 

Figure 1-6: An open chart in the work area 

 

 

1.3.5 Properties 

In the properties window, the system displays all of the available properties of the 
selected object. 

 

Figure 1-7: Properties of a selected object 

 

 

At the integrator, for example, the properties below are available: 

 General properties (object, time slice, position) 

 Inputs (values, signnals) 

 Outputs (values, signals) 

 Parameters (initial value) 

 Status 
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1.4 Changes during an ongoing simulation 

In SIMIT, the system shows simulation mode by means of orange title bars or an 
orange background. 

1.4.1 Parameters and values of objects 

You can get the system to display the properties of objects by right-clicking on 
them. 

 

Figure 1-8: Selected object during an ongoing simulation 

1

 

 

You can change the values of connections that are not connected with signals at 
any time you like. 

If connections are connected, the system displays the current value. If you 
disconnect the signal, you can, however, enter a manual (force) value. A signal 
isolator (1) is available to do this. 
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1.4.2 Changes to the simulation project 

If you want to change something in the configuration of an ongoing simulation, 
you have the option of switching between simulation view and configuration view. 
To make changes to the configuration, proceed as follows: 

(1) In project navigation, click on the "Project" tab. 

(2) Edit the desired object. 

(3) Start the "Prepare changes" function. 

(4) Start the "Activate changes" function. 

 

Figure 1-9: Changing during an ongoing simulation 

1

2

3 4
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2 Presentation of the project 
SIMIT Getting Started is carried out using a practical example. 

On the PCS 7 Engineering Station, the "SIMIT_GS_MP" is used. The project is 
based on PCS 7 Getting Started "color_gs" and was created with the following 
changes: 

 The project was updated to PCS7 Version V8.2. 

 The "RMT2" subsystem was removed from the technological hierarchy. 

 Individual control module types were generated from the process tag types. 

 

Note You can find PCS 7 Getting Started and the associated original project in the 
"SIMATIC Process Control System PCS 7 Getting Started - Part 1 (V8.2 with 
APL)" manual: 
https://support.industry.siemens.com/cs/ww/en/view/109485954 

Project design 

Getting Started is implementation of on a a PC station. The software below is 
installed on the PC. 

Table 2-1 

Software Article no. Note 

SIMATIC PCS 7 V8.2 6ES7651-5AA28-0YA0 ES Single Station 

SIMIT Simulation V9.0 SP1 6DL5260-0BX00-0YL8 SIMIT Simulation Professional 

PLCSIM - Component of PCS 7 

Virtual Controller V9 - Component of SIMIT 

 

Figure 2-1: Software installation on the test system 

SIMIT Simulation

PCS 7 Single Station

(ES / OS)

100.0

65.7
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SIMIT Simulation
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Device Level

Process Level

 

https://support.industry.siemens.com/cs/ww/en/view/109485954
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Description of the sample system 

The liquid basic substance is stored in a raw material tank and pumped as needed 
from there into one of the two reactors. It is possible to set the amount and the 
target reactor before starting the transfer sequence. 

 

Figure 2-2: Flow chart of the sample system 

Raw Material Tank
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NK
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The following designations of process tags have been used for the project: 

 

Table 2-2 

Abbreviation Meaning Note 

LI… Level Indicate Analog value acquisition (fill level) 

FI… Float Indicate Analog value acquisition (throughflow) 

NK… Valve Shut-off valves 

NP… Motor Drives, pumps 

Sel… Selection Function for selecting a destination 

Set… Setpoint Function for specifying a transfer amount 
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Task for the SIMIT Getting Started 

In SIMIT Getting Started, create the simulation model for the "SIMIT_GS_MP" 
PCS 7 project. You will get to know the procedures below when creating 
simulation models using SIMIT Simulation: 

 

 Creating a project 

 Creating a PLCSIM or a Virtual Controller coupling 

 Configuring the input and output signals 

 Creating the actuators and sensors 

 Using templates and the import function 

 Designing the physical models of the raw material tank and the reactors 

 Creating a simulation using a macro 

 Configuring a visualization 
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3 Preparing for Getting Started 

3.1 System configuration 

For communication between the Operator Station (OS) and SIMIT to work, add 
the configured network addresses to your system. The VC always needs the IP 
address on the network adapter too. If you are using PLCSIM instead of the VC, 
you can omit the IP address of the AS. You can leave the settings of network 
addresses om your PC that have already been configured as they are. 

The network addresses below were used in the sample project cartridge: 

 OS01: 192.168.7.1 (Operator Station) 

 AS01: 192.168.7.10 (Automation System) 

 

The VC uses the network address of the AS that is configured in the SIMATIC 
Manager. To operate the VC, you must assign this address on your network 
adapter. 

To set other IP addresses on your network adapter, proceed as follows: 

 

1. Open the properties of your network adapter. 

2. Open the properties of the TCP/IPv4 protocol. 

3. In the "Advanced Settings" dialog, add the following IP addresses: 

– 192.168.7.1 

– 192.168.7.10 (when using the Virtual Controller only) 

4. Apply the changed settings 

 

Figure 3-1: Advanced TCP/IP settings 
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3.2 Configuring the demo project 

First of all, download the .zip file from the entry page of this application example 
and unpack it. You can find the entry page by visiting the following link: 

https://support.industry.siemens.com/cs/ww/en/view/109485954 

 

The .zip file contains the following project archives: 

 SIMIT_GS_PCS7_V82_MP.zip 
(SIMATIC PCS 7 V8.2 multi-project archive) 

 SIMIT_V90SP1_GS_VC.simarc 
(SIMIT Simulation V9.0 SP1 project archive with VC coupling) 

 SIMIT_V90SP1_GS_PLCSIM.simarc 
(SIMIT Simulation V9.0 SP1 project archive with PLCSIM coupling) 

 

3.2.1 Configuring the SIMATIC PCS 7 project 

1. Start SIMATIC Manager. Unpack the PCS 7 project archive and open it: 
 

Figure 3-2: PCS 7 project archive 

 
 

https://support.industry.siemens.com/cs/ww/en/view/109485954
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2. Open the properties of the OS station in Component View. 

3. Enter the name of your computer in the "Computer name" field. 
 

Figure 3-3: Changing the computer name on the OS station 

 

 

4. Start the "PLC > Configure…" function 
 
Figure 3-4: Configuring the Station Configuration Editor 

 
 

5. Use the "PLC > Download" function to load the configuration into the Station 
Configuration Editor. 
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6. Open the OS project using WinCC Explorer. 

7. Open the properties of the configured computer and enter the name of your PC 
by clicking on the "Use Local Computer Name" pushbutton. 
 
Figure 3-5: Changes in the OS project 
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3.2.2 Configuring PLCSIM 

Note Skip this chapter if you are using the Virtual Controller. 
To use PLCSIM in the SIMIT environment, you need PLCSIM version 5.4 SP5 or 
above. For SIMIT to be able to access the data of PLCSIM, SIMIT and PLCSIM 
must be installed on the same computer. 

 

1. Start SIMATIC Manager and open the demo project. 

2. Start PLCSIM by clicking on the pushbutton (1) in the menu. 

3. In the drop-down list in PLCSIM. choose "PLCSIM (TCP/IP)" (2) . 

 

Figure 3-6: Starting PLCSIM and changing interfaces 

12

 

 

4. Load the configuration and the AS program in PLCSIM. To do this, run the 
"PLC > Compile and Download Objects…" command in the AS station's 
shortcut menu. 

 

Figure 3-7 "Compile and Download Objects" dialog 
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5. Set the PLCSIM to the "RUN" or "RUN-P" operating state. 
 

Figure 3-8: PLCSIM in RUN-P operating state 

 
 

6. Start the "Compile OS" wizard by running the "Compile" shortcut menu 
command on OS project "OS (1)". 

7. As the third step in the wizard, change the network connection to TCP/IP. 

 

Figure 3-9: Compile OS wizard – network connections 

 

 

8. The last step is to complete the process by clicking on the "Compile" 
pushbutton. 
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3.2.3 Exporting the symbol table 

Note Skip this chapter if you are using the Virtual Controller. 

 

SIMIT provides an import wizard for PLCSIM coupling, which allows you to easily 
import the symbols that are contained in the AS program. 

This requires one-off exportation of the symbol table from the AS program. 
To do this, proceed as follows: 

 

1. Open the symbol table of the AS program. 

2. Sort the table by addresses. 

 

Figure 3-10: Symbol table of the AS program 

 

 

3. Mark all of the input and output addresses. These will be need later on in 
SIMIT. 
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4. Export the symbols using the "Symbol Table > Export…" menu function. 
 

Figure 3-11: Exporting the symbol table 

 

 

5. Save the symbols in ASCII in a file called "SIMIT_GS_Symbols.asc". 

 

Figure 3-12: Saving the export file 
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4 SIMIT simulation project 
In the download, you will find two SIMIT projects that you can use for training 
purposes. Further on in the documentation, howver, we will configure the 
simulation model on a step-by-step basis. You only need these SIMIT projects 
if you do not want to carry out configuration yourself. 

 

Start SIMIT Simulation Unpack and open the SIMIT project archive containing 
the coupling that you want to use: 

 SIMIT_V90SP1_GS_VC.simarc – for use with the Virtual Controller 

 SIMIT_V90SP1_GS_PLCSIM.simarc – for use with PLCSIM 

 

Figure 4-1: Unpacking the SIMIT project archives 

 

 

Creating a new project 

Follow the steps below to create a new project in SIMIT: 

1. Start SIMIT Simulation 

2. Choose the "Create new project" option. 

3. Enter a project name name, e.g. "SIMIT_GS" and click on the "Create" 
pushbutton. 

 

Figure 4-2: Creating a new SIMIT project 
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5 Simulating the signal level 

5.1 Configuring the coupling 

Couplings are the interfaces between the automation system and the simulation 
model. When you select the coupling, you specify the communication partner 
with which SIMIT exchanges data. SIMIT makes available the following couplings: 

 

 PROFIBUS DP 

 PROFINET IO 

 OPC SERVER 

 OPC CLIENT 

 SHM 

 PLCSIM 

 PRODAVE 

 VIRTUAL CONTROLLER 

 

In the rest of this document, we will discuss the "PLCSIM" and "VIRTUAL 
CONTROLLER" couplings. 

 

5.1.1 Creating a PLCSIM coupling 

Note Skip this chapter if you are using the Virtual Controller. 

1. Switch to SIMIT project view. 

2. In the "Couplings" folder, double-click on the "New coupling" entry (1). 

3. In the dialog, choose the "PLCSIM" option. 

4. Change the name of the coupling to "AS01". 

5. Double-click (2) on the coupling to open it in the work area. 

6. Import (3) the input and output signals from file "SIMIT_GS_Symbols.asc". 
See Chapter: "3.2.3 Exporting the symbol table 

7. Choose "New signals" mode (4) and start the import process. 
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Figure 5-1: Importing symbols from the AS program 

1

2

3

4

 

 

Communication test with PLCSIM 

The signals have now been created in the SIMIT coupling. As early as this stage, 
you can carry out a communication test between SIMIT and PLCSIM. 

 

Note Input signals in PCS 7 are input signals in SIMIT. In PCS 7, the input signals 
have reading properties; in SIMIT, they have writing ones. 

 

Proceed as follows: 

1. Start the simulation runtime ( ) in SIMIT. PLCSIM must have been started; 
otherwise, the system issues an error message. 
 

 
 

2. Activate the signal isolator (1) so that you can operate the signal manually. 

3. Activate a binary signal using the associated switch (2), e.g. "NK113FBO" 
with address "I0.4". 

4. If the connection is working, the system displays the signal in PLCSIM in input 
peripheral "IB 0 Signal 4" (3). 
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5.1.2 Creating a VC coupling 

Note Skip this chapter if you are using PLCSIM. 

 

1. Switch to SIMIT project view. 

2. In the "Couplings" folder, double-click on the "New coupling" entry. 

3. In the dialog, choose the "VIRTUAL CONTROLLER" option. The system opens 
the "Virtual Controller Import" dialog. 

4. Choose the "SIMIT_GS_MP" PCS 7 multi-project. 

5. Click on the ">> Stations" pushbutton to get an preview of all of the created 
ASes. Here, you can deselect any ASes that you do not want. 

6. Click on the "Import" pushbutton. 
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Figure 5-2 

 

 

7. Double-click on coupling "AS01" to open it in the work area. 

 

Communication test with VC 

All of the input and output signals have now been configured in the coupling. 
As early as this stage, you can carry out a communication test between SIMIT 
and the VC. 

 

Note Input signals in PCS 7 are input signals in SIMIT. In PCS 7, the input signals 
have reading properties; in SIMIT, they have writing ones. 

 

Proceed as follows: 

 

1. Start the simulation in SIMIT ( ). This also 
starts the VC program. 

2. Load the hardware configuration of the AS 
and the AS program in the VC. To do this, 
you can use the "PLC > Compile and 
Download Objects…" function in the 
SIMATIC Manager. 
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3. Open variable table "VAT_TestComm" and start the Monitor function ( ). 
You can find this table in the "Blocks" folder of the AS program in the 
SIMATIC Manager. 

4. Activate the signal isolator (1) so that you can operate the signal manually. 

5. Activate a binary signal using the associated switch (2), e.g. "NK113FBO" 
with address "I0.4". 

6. If the connection is working, the system displays the signal in the variable 
table. 

 

Figure 5-3 

1

2

3

 

 

5.2 Normalization of the analog signals 

In PCS 7, channel blocks, e.g. "PCS7AnIn", convert process values from a raw 
value to a process value, or "PCS7AnOu", for example, from a process value to 
a raw value. The raw value is converted into a voltage or current value depending 
on the configured measurement type. The raw value is usually processed in the 
PCS 7 program as a 16-bit variable. Depending on the configured digital/analog 
converter, the least significant bits are truncated so that the number of bits 
corresponds to that of the analog converter. This means that, in a 12-bit converter, 
the four least significant bits of the 16-bit variable are ignored. 

Data exchange between PCS 7 and SIMIT via the programming interface is 
performed completely, i.e. the raw value is read or written in 16 bits (corresponds 
to two bytes). In SIMIT, there are two options for converting a raw value to the 
corresponding physical value. 

 Scaling using standard components 

 Scaling in the coupling editor 

 



5 Simulating the signal level 

 

SIMIT V9.0 Getting Started 
Entry ID: 77362399,    V1.0,    06/2017   34 
 


 S

ie
m

e
n

s
 A

G
 2

0
1

7
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

Linear scaling is carried out using the following formula: 

 

𝑓(𝑥) =  
𝑦 − 𝑦𝐿
𝑥 − 𝑥𝐿

= 
𝑦𝐴 − 𝑦𝐿
𝑥𝐴 − 𝑥𝐿

 

 

Table 5-1: Tags 

Tag Description 

𝑥 Raw value (input value) 

𝑥𝐿 Lower limit of raw value 

𝑥𝐴 Upper limit of raw value 

𝑦 Process value (output value) 

𝑦𝐿 Lower limit of process value 

𝑦𝐴 Upper limit of process value 

 

Figure 5-4 Graphic representation of the linear transformation 

Process value (y)

Raw value(x)

°C

𝑦 = 100 °C

𝑦𝐿 = 0 °C

𝑥𝐿 = -27648
 -10V 

𝑥 = 27648
 10V 

Underflow

Overflow

𝑦 = 60 °C

𝑥 = 5530

32767-32768

 

 

All of the values in the nominal range between -27648 and +27648 are converted 
into a process value. In PCS 7, the process values that exceed the nominal range 
are further converted by the channel block until they are outside the boundaries of 
the overflow or underflow. In SIMIT however, no further conversion takes place if 
the raw value exceeds the nominal range. Once the limit is reached, the converted 
process value remains constant. 
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To be able to carryout normalization, you must know the process value limits. 
In the PCS 7 project, these limits are normally configured on the input and output 
signals. Refer to the appropriate CFC plans to find out the process value limits. 

 

Figure 5-5: Determining the process limit values 

 

 

In Getting Started, the analog signals below are used with the corresponding limit 
values: 

 

Table 5-2 Process limit values 

Name Type Lower 
limit value 

Upper 
limit value 

Description 

AI_LI111 Input 0 500 Raw material tank fill Level 

AI_LI112 Input 0 1000 Fill level of reactor 1 

AI_LI113 Input 0 1000 Fill level of reactor 2 

AI_FC111 Input 0 3 Transfer flow rate 

AI_NK112 Input 0 100 Valve position NK112 

AO_NK112_C Output 0 100 Setpoint valve position NK112 
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5.2.1 Scaling using standard components 

First of all, the raw values of the PCS 7 output signals are converted from 
"Unsigned" to "Signed" and then linear scaling is carried out on them. You convert 
the values of input signals in the reverse order. 

The illustration below shows the scaling structure using components from the 
SIMIT standard library for a complete chain, i.e. from the output to the input. 

 

Figure 5-6: Scaling of process tags 

 

 

The "Unsigned2Signed" and "Signed2Unsigned" objects must be parameterized 
with 2 bytes (16 bits). Objects "Raw2Phys" and "Phys2Raw" must be 
parameterized with the process value limits. The raw value limits have already 
been prepopulated. 

 

5.2.2 Scaling in the coupling editor 

You can also scale process tags directly in the coupling editor. Due to the number 
of conversion components that are necessary for type conversion, it is advisable to 
use this variant. In the rest of the Getting started, however, scaling will be carried 
out in the chart. 

 

In the coupling editor you can choose the from the following scaling methods: 

 Unipolar 
Raw value range: 0 to 27648 
Process value range: Settable 

 Bipolar 
Raw value range: -27648 to 27648 
Process value range: Settable 

 User-defined 
Raw value range: Settable 
Process value range: Settable 
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Note You can select other scaling methods for input signals. You cannot parameterize 
them either on the raw value limits or on the process value limits and they are 
preset for special temperature measuring devices. For more information, 
refer to chapter 2.3 of the SIMATIC SIMIT (V9.0 SP1) manual. 
https://support.industry.siemens.com/cs/ww/en/view/109744640/87934457995 

 

The value range is derived from the resolution of the A/D converter, and for 
SIMATIC S7 is generally around -27648 to +27648. For this reason, we only 
use bipolar scaling in the Getting Started document. 

 

Proceed as follows: 

1. In SIMIT, open the coupling editor by double-clicking on the "AS01" coupling. 

2. Parameterize the scaling method and the process value limits. You have the 
option of setting the parameters in the list (1) or in the properties of the 
selected signal (2). 

 

Figure 5-7: Scaling in the coupling editor 

1

2

 

 

5.3 Current version 

In this chapter, you have configured the coupling to the emulated automation 
system and imported all of the necessary signals. 

As early as this stage, you can carry out signal tests and monitor signal changes 
in SIMIT by the AS program. 

https://support.industry.siemens.com/cs/ww/en/view/109744640/87934457995
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6 Simulating the device level 
In the previous chapter, we configured the coupling to the emulated AS. In SIMIT, 
you have read and write access to the signals. 

In a real application, the AS sends the control signals to the actuators, e.g. pump 
drives or valve actuators or it receives the process values of the sensors, e.g. level 
gages. In this chapter, you will configure the actuators and sensors. 

First of all, you create the simulation of a device manually. After this, you get 
to know the SIMIT help system and wizards that make possible effective 
configuration. 

 

6.1 Creating the folder structure 

The charts for the simulation are created in the "Charts" folder. It is not absolutely 
necessary to create a folder structure in SIMIT; however, it does give a much 
clearer overview of the project. 

Ideally, you would create the same folder structure in the SIMIT project as in the 
technological hierarchy in the PCS 7 project. At the latest, this is important when 
you use the SIMIT import functions. 

 

Figure 6-1: Technological hierarchy in the PCS 7 project 

 

 

Follow the steps below to create folders in SIMIT: 

1. In the shortcut menu of the "Charts" folder, choose the "New folder" item. 

2. Change the name to "Plant1". 

3. In the shortcut menu of the "Plant" folder, choose the "New folder" item. 

4. Change the name to "RMT1". 

5. Within folder "RMT1", create the following sub-folders: 
FC111, LI111, LI112, LI113, NK111, NK112, NK113, NK114, NP111. 

 

In each folder, the system automatically creates the "New Chart" function. 
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Figure 6-2: Creating a folder structure in SIMIT 
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6.2 Creating your first simulation model 

You configure simulation models in SIMIT using charts. The first thing to do is 
to create the simulation model of valve "NK111". 

 

6.2.1 Creating a new chart 

Proceed as follows: 

1. Open folder "NK111" 

2. Double-click on the "New Chart" function. 

3. Rename the chart to "NK111". 

4. Open the chart by double-clicking in the work area. 

 

Figure 6-3: New chart 

 

 

6.2.2 Pasting components 

Simulation of the valve actuator needs the following components: 

 

Table 6-1 

Symbol Qty. Name Library Description 

 

   DriveV1 Drives Simulates the actuator 
of a valve. 

 

3 Connector Connectors Connectors make 
connections within 
the project. 

 

   Output Connectors Is connected to the 
control signal of the AS. 
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Symbol Qty. Name Library Description 

 

2 Input Connectors Is connected to the 
input signals of the AS. 

 

   MUL Default Multiplier 

 

   XOR Default Exclusive OR 

 

Drag and drop the components (1) that are described in the table to the chart. 

 

Figure 6-4: Pasting library components 

1
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6.2.3 Parameterizing components 

1. Highlight the output connector (1). This displays its parameters in the 
properties window. 

2. In the tool window, switch to the "Signals" task card and filter the signals (2) 
by the name "NK111". 

3. Parameterize the output connector with signal "AS01 - NK111CTRL". This is 
the control signal of the AS program for opening and closing the valve. Drag 
the signal (3) from the signal list onto the "General > Signal" property of the 
output connector. 

4. Highlight the input connectors (4) and parameterize signals "AS01/NK111FBO" 
and "AS01/NK111FBC" in the same way. These two signals give feedback 
about the valve setting. 

 

Figure 6-5: Configuring the input and output connectors 

1

4

2

3

 

 

Note Several options are available to configure the "input" and "output" components: 

3. The value of the signal is entered manually. This method is not recommended, since, 
on the one hand, you need to know the name and, on the other hand, typing errors 
can occur that must be eliminated later on. 

4. You drag and drop the value of the signal by means of the "Signals" task card. 

5. You drag the signal from the "Signals" task card while holding down the Shift key 
and drop it onto the chart. The system automatically creates the appropriate "Input" 
or "Output" component. This is the most effective and advisable method. 
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5. Parameterize the other components as described in the table below: 

 

Table 6-2 

Component Parameter Value Description 

MUL General > Name NK111_MUL IN1 = Monitoring time of motor 
feedback in PCS 7 

Response time = Half the 
monitoring time 

Input > X1 3.0 

Input > X2 0.5 

XOR General > Name NK111_XOR If IN2="true", at output OUT, 
the system inverts the signal 
at input IN1. 

Input > IN2 False 

DriveV1 General > Name NK111_Drive Simulates the valve setting (Y) 
and the feedback signal. 

Connector General > Name NK111/HI Global connector 

Connector General > Name NK111/Lo Global connector 

Connector General > Name NK111/Y Global connector 

 

6.2.4 Interconnecting components 

Interconnect the components as shown in the illustration below. It is only possible 
to connect outputs ( ) with inputs ( ). 

 

Figure 6-6: Finished simulation model for valve "NK111" 

 

 

Using component "XOR" at the input of the valve, you can invert a High and Low 
signal. This is relevant for the safe position of the valve. The MUL component at 
the "TOpen" and "TClose" inputs should provide dynamically adapted behavior. 
Here, the feedback monitoring time (3s) of the block in the AS program is set to 
half (factor 0.5). 

The global connectors are for interchanging values between the individual charts. 
You can use them either as an output or as an input. 
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6.3 Creating further templates using CMT Import 

Since creating charts for actuators and sensors manually is very complex, it is 
advisable to use the automatic model creation features offered by SIMIT. In this 
application example, automatic model creation is described using the "CMT Import" 
function. 

 

Note For more information on the various functions provided by SIMIT for automatic 
creation of models, refer to chapter 5 "Automatic model creation" of the 
"SIMATIC SIMIT (V9.0 SP1)" Operating Manual. 

https://support.industry.siemens.com/cs/ww/en/view/109744640/73693220363 

 

For you to be able to use the "CMT Import" function in SIMIT, it is assumed that the 
points below apply: 

 The AS program has been configured using control module type (CMTs). 
 

Figure 6-7: Control module type "GS_ValveLean" 

 

 

 The AS program has been exported into an XML file (Export XML). 

 The templates in SIMIT have been configured to match the CMTs in PCS 7. 

 

NOTICE Export XML 

The "Export XML" function in SIMIATIC Manager is a SIMIT-specific function 
and is only available if you install it via a framework installation or from the 
SIMIT installation folder. 

You can find the setup routine of "Export XML" in folder "XMLTRANSFER_..." 
in the SIMIT installation folder. 

https://support.industry.siemens.com/cs/ww/en/view/109744640/73693220363
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6.3.1 Exporting an XML file from PCS 7 

Follow these steps to create the XML file: 

 

1. Open the "SIMIT_GS_MP" PCS 7 multi-project. 

2. In the context menu of the AS project, choose the "Export XML…" item. 

3. Choose a suitable storage location and click on the "Save" pushbutton to 
complete exportation. 

 

Figure 6-8: Shortcut menu item "Export XML…" in the SIMATIC Manager: 

 

 

6.3.2 Creating the "GS_ValveLean" template from a chart 

You create the templates on the "Templates" task card. There, you can create 
"User Templates" and "Project Templates". The project templates are stored 
automatically in folder "ppatt" of the project path. They are an integral part of the 
project and are archived with the project at archiving. "User Templates" are not 
stored in the project path and are not archived either. They are available for all 
of the projects being edited on the PC. 

 

Since there are other valves in the PCS 7 project apart from "NK111", you can 
use the "NK111" chart that you already created in chapter "6.2 Creating your first 
simulation model" as the first template. In this case, placeholder tags replace the 
parameters of the objects in the chart. The placeholders and partial placeholders 
below are available: 

 ChartName 

 COUPLING 

 {$ChartName}... 

 {$COUPLING}… 
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The  symbol indicates that the placeholder function is activated on the 
parameter. The placeholder function is not active if this symbol  is shown. 

 

To create the template, proceed as follows: 

 

1. In the tool window, choose the "Templates" task card. 

2. In the project window, highlight chart  "NK111" (1) and drag it to the project 
templates. 

 

Figure 6-9: Creating templates from charts 

1

2

 

 

3. Rename the new template "GS_ValveLean" (2). To do this, choose shortcut 
menu item "Rename". 

 

Note The name of the template must be identical to the name of the CMT in the PCS 7 
project. 

 

4. Double-click on the template to open it: 

5. Select the output connector in the template. 

6. In the "General > Signal" property, activate the placeholder function (  1) 
for both input fields. 

7. Enter the "COUPLING" placeholder in the first field. When the simulation 
model is generating of later, this placeholder will be changed to the connection 
name. 
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8. Enter the tag name "CTRL.PV_Out" in the second field. The name must match 
the tag name from the CMT (2). 

9. Repeat the procedure for both input signals. Enter here the 
"COUPLING / FbkOpen.PV_In" (3) and "COUPLING / FbkClose.PV_In" (4) 
placeholders. 

 

Figure 6-10: Changing the parameters in the template 

2

3

4

1

 

10. Adapt the parameters of the other objects based on the table below: 

 

Table 6-3 

Component Parameter Value 

MUL General > Name {$ChartName}_MUL 

Input > X1 0.5 

Input > X2 Valve.MonTiDynamic  

XOR General > Name {$ChartName}_XOR 

Input > IN2 Valve.SafePos  

DriveV1 General > Name {$ChartName}_Drive 

Connector General > Name {$ChartName}/HI 

Connector General > Name {$ChartName}/Lo 

Connector General > Name {$ChartName}/Y 
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Note Values "Valve.MonTiDynamic" and "Valve.SafePos" are parameters that are set 
in the control module on the "Valve" block. Function "CMT Import" reads out the 
value from the export file and assigns the value to the corresponding inputs in 
the simulation chart. You must also configure these parameters on the CMT. 

 

 

6.3.3 Creating additional templates 

The control module types below are used in the PCS 7 project: 

 GS_ValveLean 

 GS_MotorLean 

 GS_AnaMon 

 GS_ValveAna 

 GS_Dose 

 

You are already familiar with the general procedure for creating charts and 
templates from the "GS_ValveLean" template. You can now create the remaining 
templates on the basis of the following tables. 

 

NOTICE Scaling 

In these templates, scaling is carried out using the standard objects in the chart. 
If you have already carried out scaling in the coupling, remove it. 
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GS_MotorLean 

Simulates the feedback of a simple drive. 

Create a new template called "GS_MotorLean" and insert the components and 
controls below: 

 

Table 6-4: Components of "GS_MotorLean" 

Component Parameter Value 

Connectors > Output General > Signal COUPLING  / Start.PV_Out  

Standard > Analog Basic > MUL General > Name {$ChartName}_MUL 

Input > X1 0.5 

Input > X2 Motor.MonTiDynamic  

Drives > DriveP1 General > Name {$ChartName}_DriveP1 

Connectors > Connector General > Name {$ChartName}/FbkRun 

Connectors > Connector General > Name {$ChartName}/Dir 

Connectors > Connector General > Name {$ChartName}/Y 

Standard > Misc > BConnector General > Name {$ChartName}_StartLocal_BCon 

Standard > Misc > BConnector General > Name {$ChartName}_StopLocal_BCon 

Standard > Misc > BConnector General > Name {$ChartName}_TripLocal_BCon 

Standard > Misc > BConnector General > Name {$ChartName}_MaintLocal_BCon 

Connectors > Input General > Signal COUPLING  / FbkRun.PV_In  

Connectors > Input General > Signal COUPLING  / StartLocal.PV_In  

Connectors > Input General > Signal COUPLING  / StopLocal.PV_In  

Connectors > Input General > Signal COUPLING  / TripLocal.PV_In  

Connectors > Input General > Signal COUPLING  / MaintLocal.PV_In  

 

Table 6-5: Controls of "GS_MotorLean" 

Control Parameter Value 

Input > Pushbutton General > Name {$ChartName}_StartLocal_Push 

Input > Pushbutton General > Name {$ChartName}_StopLocal_Push 

Input > Pushbutton General > Name {$ChartName}_TripLocal_Push 

Input > Pushbutton General > Name {$ChartName}_MaintLocal_Push 
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Interconnect the components as shown in the illustration below: 

 

Figure 6-11: "GS_MotorLean" template 

 

 

Note The input signals for manual switches are optional connections of control module 
types. The control modules that do not use this option are not created in the 
SIMIT charts of these input connectors either. 

 

GS_AnaMon 

Simulates the feedback of an analog value process tag. 

Create a new template called "GS_AnaMon" and insert the components, controls, 
and macros below: 

 

Table 6-6: Components of "GS_AnaMon 

Component Parameter Value 

Connectors > Connector General > Name {$ChartName}/PV 

Standard > 
AnalogExtended > 
Selection 

General > Name {$ChartName}_Selection 

Standard > AnalogBasic > 
ADD 

General > Name {$ChartName}_ADD 

Input > X2 250.0 

Standard > Conv > 
Phys2Raw 

General > Name {$ChartName}_Phys2Raw 

Parameter > Phys_Lower_Limit Input.Scale\Low  

Parameter > Phys_Upper_Limit Input.Scale\High  

Standard > Conv > 
Signed2Unsigned 

General > Name {$ChartName}_Signed2Unsigned 

Parameter > Width 2 bytes 

Connectors > Input General > Signal COUPLING  / Input.PV_In  
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Table 6-7: Controls of "GS_AnaMon" 

Control Parameter Value 

Input > Switch General > Name {$ChartName}_Switch 

 

Table 6-8: Macros of "GS_AnaMon" 

Macro Parameter Value 

Basic macros > Sine General > Name {$ChartName}_Sine 

 Input > CycleDuration 5.0 

 Input > Amplitude 250.0 

 

Interconnect the components as shown in the illustration below: 

 

Figure 6-12 

 

 

Note Using the switch, you can switch over between the simulated process value 
and a sine curve. You can use the sine curve to test limit alarms, for example. 
Simulation of the process value is carried out at the process level and in 
described further on in the Getting started document. 
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GS_ValveAna 

Simulates the feedback of an analog valve. 

Create a new template called "GS_ValveAna" and insert the components below: 

 

Table 6-9: Components of "GS_AnaMon 

Component Parameter Value 

Connectors > Output General > Signal COUPLING  / CTRL.PV_Out  

Standard > Conv > 
Unsigned2Signed 

General > Name {$ChartName}_Unsigned2Signed 

Parameter > Width 2 bytes 

Standard > Conv > 
Raw2Phys 

General > Name {$ChartName}_Raw2Phys 

Parameter > Phys_Lower_Limit CTRL.Scale\Low  

Parameter > Phys_Upper_Limit CTRL.Scale\High  

Standard > AnalogBasic > 
MUL 

General > Name {$ChartName}_MUL 

Input > X1 0.5 

Input > X2 Valve.MonTiDynamic  

Drives > DriveV4 General > Name {$ChartName}_DriveV4 

Connectors > Connector General > Name {$ChartName}/HI 

Connectors > Connector General > Name {$ChartName}/LO 

Connectors > Connector General > Name {$ChartName}/Y 

Standard > Conv > 
Phys2Raw 

General > Name {$ChartName}_Phys2Raw 

Parameter > Phys_Lower_Limit Rbk.Scale\Low 

Parameter > Phys_Upper_Limit Rbk.Scale\High 

Standard > Conv > 
Signed2Unsigned 

General > Name {$ChartName}_Signed2Unsigned 

Parameter > Width 2 bytes 

Connectors > Input General > Signal COUPLING  / FbkOpen.PV_In  

Connectors > Input General > Signal COUPLING  / FbkClose.PV_In  

Connectors > Input General > Signal COUPLING  / Rbk.PV_In  

 

Interconnect the components as shown in the illustration below: 

 

Figure 6-13 
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GS_Dose 

Simulates the feedback of an analog value process tag. 

Create a new template called "GS_MotorLean" and insert the components and 
controls below: 

 

Table 6-10: Components of "GS_AnaMon 

Component Parameter Value 

Connectors > Connector General > Name {$ChartName}/PV 

Standard > 
AnalogExtended > PTn 

General > Name {$ChartName}_PTn 

Standard > BinaryBasic > 
Selection_B 

General > Name {$ChartName}_Selection 

Standard > Conv > 
Phys2Raw 

General > Name {$ChartName}_Phys2Raw 

Parameter > Phys_Lower_Limit PV.Scale\Low  

Parameter > Phys_Upper_Limit PV.Scale\High  

Standard > Conv > 
Signed2Unsigned 

General > Name {$ChartName}_Signed2Unsigned 

Parameter > Width 2 bytes 

Connectors > Input General > Signal COUPLING  / PV.PV_In  

 

Table 6-11: Controls of "GS_AnaMon" 

Control Parameter Value 

Input > Switch General > Name {$ChartName}_Switch 

 

Interconnect the components as shown in the illustration below: 

 

Figure 6-14 

 

 

Note Using the switch, you can switch over between the simulated process value and 
a substitute value. Simulation of the process value is carried out at the process 
level and in described further on in the Getting started document. 
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6.4 CMT Import 

The templates that we created in chapter 6.3 are the basis of CMT Import. AT CMT 
import, the system creates in SIMIT a chart from the corresponding template for 
each instance of a CMT. 

For example: the PCS 7 project contains three control modules of type 
"GS_AnaMon" (LI111, LI112, LI113). AT CMT import, the system now generates 
three simulation charts (LI111, LI112, LI113) from the "GS_AnaMon" template. 

The placeholder tags at the input signal are replaced by the coupling that is used 
and the symbol that is interconnected at input "Input.PV_In". For example:  

 COUPLING / Input.PV_In → AS01 / AI_LI111 

 COUPLING / Input.PV_In → AS01 / AI_LI112 

 COUPLING / Input.PV_In → AS01 / AI_LI113 

 

In the case of the partial placeholders that are used, the system replaces the 
corresponding characters. For example: 

 {$ChartName}/PV   → LI111/PV 

 {$ChartName}/PV   → LI112/PV 

 {$ChartName}/PV   → LI113/PV 

 

Carrying out CMT import 

Proceed as follows: 

 

1. Start CMT import using menu item "Automatic modelling > CMT import 

2. In the "CMT Import" dialog, choose the following settings: 

– In field CMT file, choose the XML file that you created in chapter 
"6.3.1 Exporting an XML file from PCS 7". 

– In the "Template folder" field, select the path to the "ppatt" template folder 
of the project. 

– Select the coupling that you want to use. 

 

Note The "Preview" pushbutton adds an area to the dialog in which you can have 
the system display all of the data that was created by importing. 
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Figure 6-15: Parameters at CMT import 

 

 

3. Click on the "Import" pushbutton. If charts of the same name already exist, 
you can overwrite the existing ones or cancel importation. 

4. After importing successfully, the system displays a dialog containing 
a summary. 
 

 

 

Note In the PCS 7 project, CMT "GS_MotorLean" was created with optional 
connections. Control module "NP111b" does without these connections. 
For this reason, the system indicates that it was not possible to create four tags. 
The four inputs were removed from the plan. 
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6.5 Current version 

Im chapter 6, you created the simulation models of the actuators and sensors. 
At this time, you can already monitor the behavior of the actuators and sensors in 
OS Runtime. You can now open and close valves or start drives. Apart from this, 
you can supply a substitute value, e.g. a sine value for fill levels, to the process 
tags by operating the corresponding switch on the chart. However, realistic 
operation of the plant is not yet possible. 

 

Figure 6-16 
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7 Simulating the process level 
At the process level, you simulate the physical contexts of the production facility. 
Modeling of processes and the associated physical relationships will not be 
covered in full with pre-made components. This process can be somewhat 
more complex. 

Requirements 

The following conditions apply to the creation of physical relationships: 

 The physical relationship that is to be simulated (or a simplified form of it) 
must be known 

 The device level must already have been created in SIMIT 

Preliminary considerations 

First, you must consider how to replicate the process to be simulated. When doing 
this, the effort involved in the development of the process model should not exceed 
the benefits. A simple process model is usually sufficiently accurate to test the 
automation program. 

In the present application example, simulation is needed for the following 
processes: 

 Fill level of raw material tank (0 - 500 L) 

 Fill level of reactor 1 and reactor 2 (0 - 1000 L) 

 Flow rate of RMT to reactor 1 or 2 (0 - 3 L/s) 

7.1 Creating the folder structure 

To simulate the process, add the "Model" area to the folder structure. 
Follow the steps below to create folders in SIMIT: 

1. In the shortcut menu of the "Charts" folder, choose the "New folder" item 
and rename the new folder "Model". 

2. Within folder "Model", create the following sub-folders: 
RMT1, Reactor1, Reactor2 and Transfer. 
 

Figure 7-1: Folder structure 
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7.2 Modeling material transportation 

The amount of material that is transferred from the raw material tank to the reactors 
is collected at measuring point "FC111". 

 

The following functions are simulated on the chart: 

 The pumping capacity is collected (0 - 100%) 

 The valve settings are collected (0 - 100%) 

 The volumetric flow is calculated (0 - 3 L/s) 

 

Follow the steps below to configure simulation of the transfer rate: 

1. In the "Transfer" folder create a new chart called "Transfer". 

2. Paste all of the components into the chart that are described in the table below. 

 

Table 7-1 

Symbol Qty. Name Library Description 

 

3 MinMax Standard > 
AnalogExtended 

Outputs the minimum 
or maximum value. 
The number of inputs 
is variable. 

 

2 MUL Standard > 
AnalogBasic 

Multiplies 1 to n analog 
values 

 

   ADD Standard > 
AnalogBasic 

Adds 1 to n analog values 

 

13 Connector Connectors Connectors make 
connections within 
the project 

 

3. Place, connect, and parameterize the components as shown in the illustration 
below. Also change the names of all of the objects such that you can assign 
them to the associated chart, e.g. "Transfer_MUL1" for a multiplier. 

 

Figure 7-2: "Transfer" simulation chart 

1

3

2
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Configuration notes 

(1) You can link connectors directly with the connections of other components by 
dragging and dropping them to a connection. This means that the connection 
in the form of a line is omitted and the " " component connections are not 
displayed. Both variants have equal priority. 
 

 
 

(2) Some components can carry out different tasks. For example: the "MinMax" 
component can check one or more values for a minimum value or a maximum 
value. You can choose the type in the properties under "Parameters > 
MinMax". 
 

 
 

(3) On some components, you can configure a different number of inputs. 
You can simply drag the sizing handles to increase the size of the component 
and in this way display further connections. 
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7.3 Modeling the raw material tank 

We only need a fill level for the raw material tank (RMT). The system acquires 
the fill level at measuring point "LI111". 

 

The following functions are simulated on the chart: 

 The system uses an integrator to acquire the fill level. A positive value on 
the integrator allows the fill level to rise and a negative one allows it to drop. 

 The maximum volume is 500 L. 

 The volumetric flow is applied from the "Transfer" chart. 

 If a lower value is exceeded, the fill level is incremented by 15 l/s until the 
fill level exceeds an upper value. 

 

Follow the steps below to configure simulation of the fill level: 

1. In the "RMT1" folder create a new chart called "RMT1". 

2. Paste all of the components into the chart that are described in the table below. 

 

Table 7-2 

Symbol Qty. Name Library Description 

 

   PTn Standard > 
AnalogExtended 

Integrator to calculate 
the fill level 

 

2 Selection Standard > 
AnalogExtended 

Chooses between 
two analog values 

 

2 Compare Standard > 
AnalogExtended 

Comparator can be 
configured as lower 
than or higher than 

 

   RS_FF Standard > 
BinaryExtended 

RS-Flip Flop – resetting 
has priority 

 

 

   MUL Standard > 
AnalogBasic 

Multiplies 1 to n analog 
values 

 

   ADD Standard > 
AnalogBasic 

Adds 1 to n analog values 

 

3 Connector Connectors Connectors make 
connections within 
the project 
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3. Place, connect, and parameterize the components as shown in the illustration 
below. Also change the names of all of the objects such that you can assign 
them to the associated chart, e.g. "RMT1_INT" for the integrator. 

 

Figure 7-3: "RMT1" simulation chart 

1

 

 

Configuration notes 

Some components can carry out different tasks. For example: the "Compare" 
component (1) can carry out a comparison in four different ways. You can choose 
the type in the properties under "Parameters > Comparison". 
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7.4 Modeling of reactor 1 

We only need a fill level for reactor 1. The system acquires the fill level at 
measuring point "LI112". 

 

The following functions are simulated on the chart: 

 The system uses an integrator to acquire the fill level. A positive value on 
the integrator allows the fill level to rise and a negative one allows it to drop. 

 The maximum volume is 1000 L. 

 The volumetric flow is applied from the "Transfer" chart. 

 If an upper value is exceeded, the fill level is decremented by 15 l/s until the fill 
level falls short of a lower value. 

 

Follow the steps below to configure simulation of the fill level: 

1. In the "Reactor1" folder create a new chart called "Reactor1". 

2. Paste all of the components into the chart that are described in the table below. 

 

Table 7-3 

Symbol Qty. Name Library Description 

 

   PTn Standard > 
AnalogExtended 

Integrator to calculate 
the fill level 

 

   Selection Standard > 
AnalogExtended 

Chooses between 
two analog values 

 

2 Compare Standard > 
AnalogExtended 

You can configure 
comparators for different 
comparisons 

 

   RS_FF Standard > 
BinaryExtended 

RS-Flip Flop – resetting 
has priority 

 

 

   ADD Standard > 
AnalogBasic 

Adds 1 to n analog values 

 

2 Connector Connectors Connectors make 
connections within 
the project 
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3. Place, connect, and parameterize the components as shown in the illustration 
below. Also change the names of all of the objects such that you can assign 
them to the associated chart, e.g. "Reactor1_INT" for the integrator. 

 

Figure 7-4 

 

 

7.5 Modeling of reactor 2 

The simulation model for reactor 2 is identical to the one for reactor 1. 
For this reason, you can simply copy the chart and then adapat the parameters 
appropriately. The system acquires the fill level at measuring point "LI113". 

 

Proceed as follows: 

1. Copy the "Reactor1" chart and paste it into the "Reactor2" folder. 

2. Rename the chart to "Reactor2". 
 

 
 
 

3. Change the parameters and the names of all of the objects to match the use of 
reactor 2. 
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Figure 7-5 
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7.6 Current version 

In chapter 7, you configured simulation of the physical behavior of the system. 
You are now in a position to test the AS program for correct functioning. 

With OS Runtime started, you can, for example, execute the sequential function 
chart for material transfer or analyze the behavior of dosing with changed 
parameters. 

In the simulation charts, it is also possible to view the individual process values 
in the properties of the components. 

 

Figure 7-6 
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8 Visualization in SIMIT 
SIMIT gives you the option of adding a graphical user interface to the simulation. 
In this way, you can carry out operation and monitoring of the system directly in the 
simulation regardless of whether your automation system has a visualization facility 
or not. 

There are several components in the Tools menu that allow you to do this. On the 
"Controls" task card, you can find components like analog or digital displays, for 
example, that you can use to display process values. Apart from this, there are 
switches, pushbuttons, and sliders there that can be used to enter values and 
signals. 

In this chapter, you will create in SIMIT the graphical user interface for your system 
as shown in the screenshot below: 

 

Figure 8-1: Graphical user interface in SIMIT 

 

 

The illustration includes static and dynamic components as well as components for 
the input and output of values and signals. 
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8.1 Creating graphics 

In principle, it does not matter how you create the graphics for visualization. 
The best thing to do is to use the graphics tool that you are most familiar with. 
SIMIT can display the following image formats: "bmp", "jpg", "jpeg", "png", "gif", 
"tiff", and "ico". You can also use the integrated SIMIT graphics functions to draw 
the image; however, you will soon realize that the options are very limited and 
your charts will not be very clear. 

 

Note All of the images that have been created in this application example are also 
in the download file that has been made available. 

 

You need the graphics below for the sample system: 

 Vertical and horizontal valves in the "Closed" (gray) and "Open" (green) 
operating states. 

 Drives in the "Off" (gray) and "On" (green) operating states. 

 A background image including the containers and pipes 
(Since the valves and drives are always visible, you can draw the gray variants 
directly into the background image) 

 

If you can access configuration of the OS (OS-Engineering) from PCS 7, 
you can also use these graphics easily. We will address this procedure below. 

 

Note The images that are used in the example are in folder "SIMIT_GS_Pics" 
in the download archive. 
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8.1.1 Preparing the background image 

Follow the steps below to prepare the background image: 

 

1. Open the plant display using the WinCC Graphics Designer. Create a copy of it 
(Save as….) 

2. Adapt the background color of the WinCC picture (e.g. to white) and deactivate 
the grid display. 

3. Remove all of the components from the picture that you do not want to use 
later. 

 

Figure 8-2: Original and adapted WinCC picture 

 

 

8.1.2 Creating symbols 

You can create the symbols of the drives and valves in the Graphics Designer too. 
There are a number of options available for this, e.g. you could use the "Dissolve 
user objects" function to break down APL block icons into all of their individual 
components. However, they contain a lot of objects and are unclear. 

The easiest thing to do is to insert a graphics object into the WinCC picture and 
to assign the corresponding APL symbol as an image. All of the APL symbols in 
the OS project are in EMF format. 

 



8 Visualization in SIMIT 

 

SIMIT V9.0 Getting Started 
Entry ID: 77362399,    V1.0,    06/2017   69 
 


 S

ie
m

e
n

s
 A

G
 2

0
1

7
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

Proceed as follows: 

1. Create a new WinCC picture called "SIMIT Symbols.pdl". 

2. Insert a "Graphic Object" (1) in the WinCC picture and choose a square shape 
(2). For example: "Geometry > Width / Height = 40". 

3. Select the APL pictogram for a started drive "apl_bi_MotL_on_down.emf" (3). 

4. In the properties choose the "Effects > Global Shadow / Global Color Scheme 
= No" setting. 

5. Create six copies of the inserted picture and and choose the pictograms below 
for display: 

– apl_bi_MotL_off_down.emf 

– apl_bi_VlvAnL_closed_V8.emf 

– apl_bi_VlvAnL_opened_V8.emf 

– apl_bi_VlvAnL_closed_90_V8.emf 

– apl_bi_VlvAnL_closing_90_V8.emf 

– apl_bi_VlvAnL_opened_90_V8.emf 

 

Figure 8-3 

1

2

3

4

 

6. Copy the gray symbols into the WincC picture that shows the background of 
SIMIT. 
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Figure 8-4: SIMT background picture created in WinCC Graphics Designer 

 

 

Note Since the gray symbols in SIMIT are always displayed, they can also be 
components of the background picture. This will reduce the number of objects 
in the SIMIT project later. 

 

8.1.3 Creating graphics 

Using the WinCC Graphics Designer, you can export pictures but this is only 
possible in EMF format that SIMIT cannot read. This makes it necessary to convert 
to a different format using an external graphics program. 

To minimize the amount of time and effort needed for this, the best thing to do is 
to use a screenshot tool (like the Windows 7 Snipping Tool, for example) to create 
the graphic. 

 

Proceed as follows: 

1. Open the picture containing the SIMIT background in the Graphics Designer. 
Make sure that the display size is 100%. 

2. Grab a screenshot and crop the unneeded areas. If you use the Snipping Tool, 
you can use the Rectangular Snip setting to select the necessary area when 
you grab the screenshot. 
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3. Save the picture in PNG format. The background image should look something 
like this: 

 

4. Open the picture containing the SIMIT symbols in the Graphics Designer. 
Make sure that the display size is 100%. 

5. In each case, grab a screenshot of the colored symbols and crop the 
unneeded areas. 

6. The individual symbols should be in the same image format as was set in 
WinCC. For example: 40x40 pixels. 

7. Save the individual symbols in PNG format. The symbols should look 
something like this: 

    

 

Note Use PNG-format graphics with a transparent background for the pictograms. 
This improves the display quality in the SIMIT project. 
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8.2 Creating visualization in SIMIT 

To visualize the process, add the "Visualization" area to the folder structure. 
Proceed as follows: 

1. In the shortcut menu of the "Charts" folder, choose the "New folder" item and 
rename the new folder "Visualization". 

2. In the folder create a new chart called "Visualization". 
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8.2.1 Creating a plant display 

Follow the steps below to configure the background image: 

1. Open the "Visualization" chart and adapt the size to the background image 
that you created before. In the example, the background image measures 
1200 x 800 pixels 

2. In the properties, choose the background image in "General > Background 
image". 

3. Use the "Text" graphic object to insert labels into the picture. 

 

Figure 8-5 

 

 

8.2.2 Displaying process values 

You can simply drag signals into the chart from the signal list. In this way, 
you insert the objects below into the chart: 

 A text field containing the signal name 

 A digital input control that has already been configured with the signal to 
be displayed 

 A signal isolator for manual entry of a substitute value (forcing) 

 

However, not every signal is suitable for display on the chart. For example: signal 
"AS01/LI111" (fill level of raw material tank) has already been converted into the 
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raw format for the controller. To be able to display the fill level correctly on the 
chart, you can use a signal that is available before conversion. 

 

Proceed as follows: 

1. Open simulation chart LI111. 

2. Select the last component (1) before conversion and make a note of the 
name (2) of the object. 
 

2

1

 

 

3. Search for output signal "Y" of the object in the signal list and drag and drop it 
to the visualization chart. 

 

3
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4. Change the label of the signal to "Level Raw Material Tank". 

5. Add the signals below in the same way: 

– Reactor 1: "LI112_Selection / Y" 

– Reactor 2: "LI113_Selection / Y" 

 

8.2.3 Configuring operator controls and displays 

In the simulation, it is intended for the system to be able to display the fill levels 
of the containers using a simulated process value or a sine value. At pump drive 
"NP111a" it should be possible to make local inputs using four signals. It should be 
possible to visualize the servo position of analog valve "NK112" using a bar graph. 

 

You need the following objects: 

 

Table 8-1 

Symbol Name Library Description 

 

Text Graphic > Graphic tools Text box 

 

Switch Controls > Input Switch for a binary 
signal 

 

Digital input Controls > Input Input field for process 
values 

 

Bar graph 
display 

Controls > Display Graphic display for 
process value 

 

Proceed as follows: 

 

1. Using Controls > Input > Switch, add a switch (1) to the chart and parameterize 
the following properties: 

– General > Name = "LI111_Switch_Amp" 

– Connector > Signal = "LI111_Switch / X" (2) 

2. Using Controls > Input > Digital Input, add an input field to the chart and 
parameterize the following properties: 

– General > Name = "LI111_DI_Amp" 

– Connector > Signal = "LI111_Sine / Amplitude" 

3. Add text boxes with corresponding labels. 
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Figure 8-6: Inserting operator controls 

1

2

3

4

 

4. Use the same method to add controls and labels for reactors 1 and 2 and 
pump drive "NP111a" (4). Use the signals that are described in the table 
below: 
 

Table 8-2 

Control Parameter Value 

Input > Switch General > Name LI112_Switch_Amp 

Connector > Signal LI112_Switch / X 

Input > Digital Input General > Name LI112_DI_Amp 

Connector > Signal LI112_Sine / Amplitude 

Input > Switch General > Name LI113_Switch_Amp 

Connector > Signal LI113_Switch / X 

Input > Digital Input General > Name LI113_DI_Amp 

Connector > Signal LI113_Sine / Amplitude 

Input > Switch General > Name NP111a_Switch_Trip 

Connector > Signal NP111a_TripLocal_Push / X 

Input > Switch General > Name NP111a_Switch_Maint 

Connector > Signal NP111a_MaintLocal_Push / X 

Input > Switch General > Name NP111a_Switch_StartL 

Connector > Signal NP111a_StartLocal_Push / X 

Input > Switch General > Name NP111a_Switch_StopL 

Connector > Signal NP111a_StopLocal_Push / X 
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Note You can reduce the time and effort needed for configuration by selecting several 
objects and copying them. To do this, drag a frame around the desired objects 
and press <Ctrl+C> to copy them and <Ctrl+V> to paste them. 

 

After this, change the parameters of the copied objects. 

 

5. Use "Controls > Display > Bar graph display" to add a bar graph display with 
the parameters below to the chart: 

– General > Name = "NK112_Pos_BarDisplay" 

– Connector > Signal = "NK112_DirveV4 / Y" 

– View > Orientation = "Vertical" 

 

Figure 8-7: Visualizing the valve position 
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8.2.4 Animating device icons 

You need several animated graphics in the chart to visualize the drives, 
the operating status of a valve, or the fill level of a container. 

Below, we will show you how to dynamize objects from the "Graphic > Graphic 
tools" library. The additional "Animations" property is available for these objects. 

Follow the steps below to display an open valve: 

1. Insert a rectangle in the chart with the following parameters:  
(The side length of the picture to be displayed is 40 pixels) 

– General > Name = "NK111_Pic_Open" 

– Appearance > Fill color > Image… = "GS_SIMIT_VlvL_90_Opened.png" 

– Appearance > Line color = "No color" 

– Layout > Width = "40.0" 

– Layout > Height = "40.0" 

2. Position the picture directly above the representation of the closed valve 
NK111 in the background. If you use the supplied sample graphics, this is 
position X=566, Y=208. 

3. In chart NK111, determine the signal that is set when the valve is open. 
For valve NK111, the signal is "NK111_Drive / Hi". 
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4. Add a new animation to the graphic object. To do this, double-click in 
Properties on "Animations > New animation". Create the animation "Visibility" 
using the following parameters: 

– Animations > Visibility > Signal = "NK111_Drive / Hi" 

– Animations > Visibility > Visible if signal 'True' = Yes 

 

Figure 8-8: Animated valve symbol 

 

 

5. Create six copies of the graphic object that you have just generated and 
change the parameters on the basis of the table below: 

 

Table 8-3 

Symbol Parameter Value 

Motor NP111a 

 

General > Name LI111a_Pic_On 

Appearance > Fill Color > Image GS_SIMIT_MotL_Run.png 

Animations > Visibility > Signal NP111a_DriveP1 / FB_Run 

Animations > Visibility > Visible if signal 'True' Yes 

Motor NP111b 

 

General > Name LI111b_Pic_On 

Appearance > Fill Color > Image GS_SIMIT_MotL_Run.png 

Animations > Visibility > Signal NP111b_DriveP1 / FB_Run 

Animations > Visibility > Visible if signal 'True' Yes 

Valve NK112 

 
(Display from 5%) 

General > Name NK112_Pic_Half 

Appearance > Fill Color > Image GS_SIMIT_VlvL_90_Half.png 

Animations > Visibility > Signal NK112_DriveV4 / LO 

Animations > Visibility > Visible if signal 'True' No 
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Symbol Parameter Value 

Valve NK112 

 
(Display from 
95%) 

General > Name NK112_Pic_Open 

Appearance > Fill Color > Image GS_SIMIT_VlvL_90_Opened.png 

Animations > Visibility > Signal NK112_DriveV4 / HI 

Animations > Visibility > Visible if signal 'True' Yes 

Valve NK113 

 

General > Name NK113_Pic_Open 

Appearance > Fill Color > Image GS_SIMIT_VlvL_Opened.png 

Animations > Visibility > Signal NK113_Drive / HI 

Animations > Visibility > Visible if signal 'True' Yes 

Valve NK114 

 

General > Name NK114_Pic_Open 

Appearance > Fill Color > Image GS_SIMIT_VlvL_Opened.png 

Animations > Visibility > Signal NK114_Drive / HI 

Animations > Visibility > Visible if signal 'True' Yes 

 

Note From 5% opening onward, valve NK112 shows the symbol for the intermediate 
position. From 95% onward, the system displays the symbol for the open valve. 
When configuring, make sure that the "open" symbol is above the "half-open" 

symbol. You can use the  commands on the toolbar to change the display 
level. 

 

6. Place all of the symbols exactly above the corresponding ones in the 
background image. 
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Figure 8-9: Visualization using animated symbols 

 

 

8.2.5 Animating tank fill levels 

To animate fill levels, you need two rectangles that are above one 
another in each case. The rear rectangle is the background and 
represents the empty tank. This rectangle is not animated. 
The size and position of the front rectangle are animated. 
It represents the fill level of the tank. 

When the tank is 100% full, you can see a border of about one 
pixel around the rear rectangle, which gives the impression of 
a frame. 

 

Proceed as follows: 

1. Insert a "Rectangle" graphic object in the chart with the following parameters: 

– General > Name = "LI111_Bar_Back" 

– Appearance > Fill color = black 

– Appearance > Line color = "No color" 

– Layout > Position = X=610, Y=50 

– Layout > Width = 25 

– Layout > Height = 115 

2. Insert another rectangle in the chart with the following parameters: 

– General > Name = "LI111_Bar_Front" 

– Appearance > Fill color = green 

– Appearance > Line color = "No color" 

– Layout > Position = X=611, Y=163 
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– Layout > Width = 23 

– Layout > Height = 1 

 

Note The size and positions of the rectangles depending on the background graphic 
that you use, of course. The coordinates that are stated here refer to the 
supplied background image. 

 

This is now the initial representation of the bar graph. For animation, you must first 
determine a few values and make calculations. You need the parameters below 
for the animation: 

 Process value (signal) 

 Range (minimum and maximum fill level 

 Scaling factor 

 Relative distance 

 

You determine signal (LI111_Selection / Y) for the process value as shown in 
chapter "8.2.2 Displaying process values". You can determine the minimum fill 
level and the maximum fill level (1) in chart RMT1. 

Figure 8-10: Determining values in the chart 

1

 

 

The object is only scaled in the Y direction starting from the parameterized height 
(1 pixel) and it is calculated using the following formula: 

𝑆𝑐𝑎𝑙𝑖𝑛𝑔 𝑌 = 100 ∗ 𝐻𝑒𝑖𝑔ℎ𝑡 + 100 = 100 ∗ 113 + 100 = 11400 

 

Note The height corresponds to the height of the rectangle when 100% filled. 

 

Since the rectangle is always drawn from the top right, you must use the formula 
below to calculate the distance relative to the height: 

𝐷𝑖𝑠𝑡𝑎𝑛𝑐𝑒 𝑌 = −1 ∗ 100 ∗ 𝐻𝑒𝑖𝑔ℎ𝑡 = −1 ∗ 100 ∗ 113 = −11300 

 

3. Use "New Animation > Scaling" to create scaling for the "LI113_Bar_Front" 
object with the following parameters: 

– Scaling > Signal = "LI111_Selection / Y" 

– Scaling > Initial value = 0.0 
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– Scaling > End value = 500.0 

– Scaling > Scaling = X=100.0, Y=11400.0 

– Scaling > Distance = X=0.0, Y=-11300.0 

 

Figure 8-11: Animated rectangle to represent a fill level 

 

4. Create two copies of both rectangles for the reactors' fill level displays 
and change the parameters in accordance with the following table: 

 

Table 8-4 

Object Property Value 

Bar graph 
of reactor 1 
background 

General > Name LI112_Bar_Back 

Layout > Position  X=215, Y=595 

Layout > Width 15 

Layout > Height 145 

Bar graph 
of reactor 1 
foreground 

General > Name LI112_Bar_Front 

Layout > Position  X=216, Y=738 

Layout > Width 13 

Layout > Height    

Animations > Scaling > Signal LI112_Selection / Y 

Animations > Scaling > Initial Value 0.0 

Animations > Scaling > End Value 1000.0 

Animations > Scaling > Scaling X=100, Y=14400 

Animations > Scaling > Distance X=0, Y=-14300 

Bar graph 
of reactor 2 
background 

General > Name LI113_Bar_Back 

Layout > Position  X=990, Y=595 

Layout > Width 15 

Layout > Height 145 

Bar graph 
of reactor 2 
foreground 

General > Name LI113_Bar_Front 

Layout > Position  X=991, Y=738 

Layout > Width 13 

Layout > Height    

Animations > Scaling > Signal LI113_Selection / Y 
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Object Property Value 

Animations > Scaling > Initial Value 0.0 

Animations > Scaling > End Value 1000.0 

Animations > Scaling > Scaling X=100, Y=14400 

Animations > Scaling > Distance X=0, Y=-14300 
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8.3 Current version 

In chapter 8, you added a graphical user interface to the simulation. You are now 
in a position to monitor the simulation in SIMIT and to make some settings. 
The system shows the process values of the tank fill levels as text and as graphics. 
The icons of the drives and the valves display the current status. 

 

Figure 8-12: Graphical user interface in SIMIT. 
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9 Appendix 

9.1 Service and Support  

Industry Online Support 

Do you have any questions or need assistance?  

Siemens Industry Online Support offers round the clock access to our entire 
service and support know-how and portfolio.  

The Industry Online Support is the central address for information about our 
products, solutions and services.  

Product information, manuals, downloads, FAQs, and application examples – 
all the information you need is accessible with just a few mouse clicks at:  
https://support.industry.siemens.com 

Technical Support 

The Technical Support of Siemens Industry provides you fast and competent 
support regarding all technical queries with numerous tailor-made offers – 
ranging from basic support to individual support contracts. 

Please send queries to Technical Support via Web form:  
www.siemens.de/industry/supportrequest 

Service offer 

Our scope of services includes, inter alia, the following:  

 Product trainings 

 Plant data services 

 Spare parts services 

 Repair services  

 On-site and maintenance services 

 Retrofitting and modernization services 

 Service programs and contracts  

You can find detailed information on our range of services in the service catalog: 
https://support.industry.siemens.com/cs/sc 

Industry Online Support App 

The "Siemens Industry Online Support" app provides you with optimum support, 
including while on the road. The app is available for Apple iOS, Android and 
Windows Phone: 
https://support.industry.siemens.com/cs/ww/en/sc/2067 

 

 

  

https://support.industry.siemens.com/
http://www.siemens.en/industry/supportrequest
https://support.industry.siemens.com/cs/sc
https://support.industry.siemens.com/cs/ww/en/sc/2067
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9.2 Links and Literature  

Table 9-1 

No. Topic 

\1\ Siemens Industry Online Support 

https://support.industry.siemens.com 

\2\ Link to the entry 

https://support.industry.siemens.com/cs/ww/en/view/77362399 

\3\ "SIMATIC SIMIT (V9.0 SP1)" manual 

https://support.industry.siemens.com/cs/ww/en/view/109744640 

\4\ SIMIT Simulation Overview 

https://support.industry.siemens.com/cs/ww/en/view/109746429 

 

 

9.3 Documentation of changes 

Table 9-2 

Version Date Change 

V1.0 06/2017  First version 

   

 

https://support.industry.siemens.com/
https://support.industry.siemens.com/cs/ww/en/view/77362399
https://support.industry.siemens.com/cs/ww/en/view/109744640
https://support.industry.siemens.com/cs/ww/en/view/109746429
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